
~ 1 ~ 
 

   
 

_____________________________________________________ 
 
 

QuickPix – QuickPix is a great way to share your images with the club.  Upcoming 
opportunities are: 
 Seascapes and Coastal Shots – submit images between August 30th and September 7th  
 Night Sky – submit images between September 14th and 21st  
 
Mentoring Opportunity - Rick Strobaugh will repeat his successful RCC Mentor Circle 
at 5:30pm before the Oct. 19 meeting.  Newer members in particular can benefit from 
this service, gaining information, engaging with others and feeling welcome to the 
Redlands Camera Club.  If you are interested please email Rick at 
rpdrunner@msn.com.  
 
Pre Meeting Slideshow Photos - If you want bragging rights for including your images 
for the slide show at the start of the meeting, send them to Steve Oberholtzer at 
stevetob1@verizon.net. Make sure images are sized for competition and they will be in 
the next pre-meeting slideshow. 12 seconds of fame! What a deal! 
 
Photogram – If you have photo equipment that you are looking to sell, why not let club 
members know.  Let me know by the 3rd Thursday of the month and it will be included 
in the next Photogram. 

Programs for September & October 2015 

 
 

Details for the current month’s programs may be found in the Programs article, starting page 3.

  

September 7th September 21st October 5th October 19th 

Shooting the 
California Coast 

 
With 

Ralph Nordstrom  
 

Blending 
Astronomy and 

Photography 
  With 

Dr. Tyler Nordgren  

Members’ Night 

Submit Images 
Between September 
28th and October 5th  

  

Pre Meeting 
Mentoring 

 
Doors Open @ 

5:30pm 

PHOTOGRAM 
Monthly Newsletter of the Redlands Camera Club 

September 2015 
Redlands Camera Club meets:  1st & 3rd Mondays, 7:00 pm 
First Presbyterian Church - 100 Cajon St - Redlands, CA 

Guests are always welcome 
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Carl Detrow 
 
      

Shooting in the Desert 
Back in the late 60’s I was stationed at a desert test range just west of the Great Salt 

Lake. There wasn’t much to do out there so I, like several others, bought a plinking rifle so I could 
amuse myself putting .22 rounds into pre-recycling era beverage containers. Little did I know back 
then that desert shooting would take on all new meaning for me in 2015.  

In August I took what was for me the best field trip/workshop I’ve experienced since I’ve been 
associated with the Redlands Camera Club. To be honest there have been other great field trips that 
for one reason or another I’ve been unable to attend. Some have been overnighters, some have been 
to locations not so close (Bryce Canyon comes to mind, a lot of fun for those who went), and some 
just didn’t fit in my schedule. After the Borrego Springs experience I truly regret missing every one of 
them. 

I had to agree with Frank Peele when he strongly advised during the classroom session to avoid 
driving back to Redlands in the wee hours, so my wife and I stayed a couple of nights in the town, 
although nights weren’t spent in the room. Frank and I were there a day early so we were able to 
scout out the sculptures we wanted to photograph in the daylight before we went out for a view of the 
Perseid meteor shower backlit by the Milky Way. While there we met a couple of professional 
photographers with exotic equipment making beautiful images. We got some great shots and were 
well prepared for the next night. 

The next evening was the best part as nearly 30 club members braved the 115+ temperatures for 
what turned out to be the highlight of the shoot. We took a short tour of a few of the sculptures, then 
met for dinner. The pace is slow in the desert in August, and the service matched. But that turned out 
to be a good thing as there was plenty of time to get to know fellow members and swap stories of life 
experiences, not all of them photographic.  The range of talent in our club still greatly impresses me 
every time we get together. And those of us less talented, but just as passionate about our art, drank 
it all in and learned, something we never could have done on a solo trip to the Anza-Borrego.  

So thanks to everyone involved in the workshop/field trip, especially Frank and Debra, those who 
provided radios and carpooling, and everyone who attended. We learned some lessons, and will 
apply them, hopefully in the spring when the el Niño wildflowers emerge. 

 
Happy Shooting 
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Jim Hendon 

 

 

September 7th – Shooting the California Coast  
Ralph Nordstrom 

Crashing surf. Tranquil lagoons. Colorful tide pools. Dramatic cliffs 
and wind-twisted trees. The Golden State’s 1,000-mile coastline 
offers a treasure of photo opportunities – but while this shooter’s 
paradise is easy to access, getting a truly great image is harder than 
it looks. Join your RCC comrades and Southern California-based 
photographer Ralph Nordstrom on Sept. 7 to learn where, when and 
how to shoot magnificent seascapes.  Ralph specializes in 
photographing the drama and might of Big Sur, but the knowledge he 
will share can be applied all up and down the coast.  Before the 

presentation, we will enjoy Quickpix of RCC members’ best seascapes and coastal shots from 
California and other locations (submit up to 3 images to the RCC web site between August 30th and 
September 7th. Ralph “grew up on nature and art,” learning landscape painting from his dad, playing 
piano and backpacking the Sierra with a Pentax SLR. For the past decade, he has devoted himself to 
the pursuit of photography, following his heart, building his technical skills and honing his creative 
vision. His journey continues today, marketing fine-art photographs via his web site, doing 
presentations (including the "Four Pillars of Landscape Photography"), blogging on nature 
photography and leading workshops from Zion to Death Valley. Next: Big Sur in November. 

September 21st – Blending Astronomy and Photography 
Dr. Tyler Nordgren  

Learn to photograph the night-sky and see our visible universe in 
new ways on Sept. 17 with Dr. Tyler Nordgren, University of 
Redlands professor of physics and astronomy, and author of Stars 
Above, Earth Below: A Guide to Astronomy in Our National Parks. 
With a Ph.D. in astronomy from Cornell University, Dr. Nordgren has 
developed expertise ranging from dark matter in galaxies, to the 
pulsation of stars and the size and age of the universe – and he has 
helped to design instruments used aboard NASA’s rover expeditions 

to Mars. Concerned about the steady intrusion of city lights obscuring our night skies, Dr. Nordgren 
has worked with the national parks to promote astronomy education in special, dark places which still 
offer clear views of the universe. He has shared his award winning night-sky photography throughout 
the country – and launched a poster campaign (“Half the Park is After Dark!”) with the National Park 
Service to promote night-sky appreciation and protection. Supported in part by The Planetary Society, 
Dr. Nordgren’s work encourages an integrated understanding of the universe with geology, art, 
history, Native American studies, exploration and environmental conservation. A former director of the 
International Dark-Sky Association, Dr. Nordgren regularly gives talks to visitors and rangers in the 
national parks (he recently led a night-sky raft trip through the Grand Canyon). For this RCC program, 
we will also share members’ images of night skies in a Quickpix session before the presentation 
(submit up to 3 images to the RCC web site between Sept. 14 and morning of Sept. 21). Join us for 
what promises to be both an informative and inspiring evening! 
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John Williams
 

 

If you haven’t paid your dues, your Membership for 2015-2016 is way past due! 
Presently we have 130 members who have renewed their membership.  However, many members 
(over 50) have not renewed their membership.  Renewal is as easy as going to the club web site 
(www.redlandscameraclub.com), clicking on the “Downloads” tab and downloading the “Membership 
Application” file.  Follow the instructions on the form and your all set!  Dues are the primary sources of 
club revenue allowing us to provide you with quality programs and training.  Only currently paid 
member can take part in RCC classes, events, free workshops, field trips and competitions. 
Please welcome our newest members who joined in recently: 

Francine Landau 
Dave Moore (previous members who has been absent) 
Thorne Sandra 
Marilyn Simone 
Neil Williams 

Debra Dorothy  

             
 

Bolsa Chica Ecological Reserve 
Date:  September 27th Sunday 
Location: Bolsa Chica Ecological Reserve 3842 Warner Ave. 
Huntington Beach, CA 92649-4263 
Time: 7:00AM - Whenever people want to leave. 
Equipment needed:  You will want to bring your longest lens, fresh 
batteries and memory cards. Bring lots of water and either a lunch or 
snack. I went there a couple of weeks ago and there were a lot of 
birds. There are also birding opportunities for those with shorter 

lenses at a couple of places on the beach across the street. 
After the event we will meet at a Mexican Restaurant near there for dinner before returning home. 
This restaurant also has vegan dinners for those who are interested. 
We will meet at the Coco's in Redlands at 7:00AM to carpool to Bolsa Chica. Please email me ahead 
of time to let me know if you are attending and if you would like to carpool. If you have any questions 
please email me at Debbiedsd.dorothy@gmail.com. 
 

If you have any questions, please email:  Debbiedsd.dorothy@gmail.com 
  

https://www.google.com/url?sa=t&rct=j&q=&esrc=s&source=web&cd=1&cad=rja&uact=8&ved=0CCAQFjAAahUKEwjL1OPI_q7HAhWUNYgKHYDjABc&url=http%3A%2F%2Fwww.dfg.ca.gov%2Flands%2Fer%2Fregion5%2Fbolsachica.html&ei=9DvRVcuKJJTroASAx4O4AQ&usg=AFQjCNFYUlgXtqq5lWnSUZRJqY6gOYOC4A&sig2=Vx_vsGdggPuf8tFJmt5vMQ
mailto:Debbiedsd.dorothy@gmail.com
mailto:Debbiedsd.dorothy@gmail.com
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Wayne (Woody) Wood 

 
 

Manuel Dario Castellanos  

Mother Nature has never produced an "ordinary" object or living thing. 
Extraordinary too, are the works of Manuel Castellanos, an artist with 
the gift of bringing the beauty of nature and everyday things to our 
attention through a sharp eye and the lenses of his camera. 
Manuel, a former glazier who found his true calling in midlife, 
ascended the ranks of the local photography scene through strict 
adherence to a professional credo and dedication to his craft. He 
sharpened his credentials through training at the TRI Community 
School of Photography, Covina, California. 
Utilizing his Nikon D80 with 18-105 lens, Manuel, a proud 
Guatemalan-American, takes his inspiration from the glory of his 
Ancient Mayan heritage and brings his worldview to the objects which 
surround us but we never see, and like a true artist, captures his 
subjects in that instant, at that unrepeatable moment and cements the 
images in a digital space. Thus, every piece is unique and is one 
reason why Manuel's works are to be valued. 

His works have been exhibited at art shows in San Juan Capistrano, Monrovia, Sierra Madre and Big 
Bear, California and at The Parkhurst Gallery and San Pedro Art Association, in San Pedro, California 
Manuel's color and black and white images can be printed on canvas or photo-quality paper stock 
and are expertly mounted and framed for delivery. 
When an executive office, a public space or a home is in need of a special thing of beauty, give 
consideration to one or more of the works of this rising star who labors within our midst. 
Manuel Castellanos is indeed one of our homegrown treasures. 
His works are available for a private viewing at 9355 Calle Vejar, Rancho Cucamonga, CA. 91730. 
Call 909 223-3595 or e-mail castellanosphotography@yahoo.com for more details. 
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Frank Peele  
 
 
Borrego Springs Night Sky Workshop/Field Trip 

We had a wonderful time shooting Meteors, the Milky Way and the 
Ricardo Breceda sculptures in the workshop/field trip to Borrego 
Springs. The Perseid meteor shower was less dramatic than expected, 
but still inspiring. The Milky Way put on a great show, and the 
sculptures never cease to be photogenic – day or night. Thirty-two 
RCC members participated, including several who joined specifically 
for the event. We look forward to seeing night sky images as QuikPix 
at the Sep. 21 meeting, before astronomy professor Tyler Nordgren 

presents his fascinating program “Blending Astronomy and Photography”.  
 

Upcoming Workshop 
You’ve seen his eye-popping images in Members’ Nights and the last RCC 
competition, and now Carl O’Day has offered to reveal his secrets of shooting 
“splashes” in a workshop to be held this fall. As soon as we work out a suitable venue 
(there will be lots of liquid flying around!) and have a date scheduled, we’ll announce 
the event. This one may be limited in the number of members we can accommodate, 
so you’ll want to sign up quickly when the announcement is made. 
 
 

New Classes and Workshops Coming Soon 
You’ve submitted your surveys, they’ve been collated and studied, and as a result we’re busy 
formulating the schedule for the 2015/2016 session of the RCC School of Photography. There will be 
a more hands-on emphasis where feasible, both in classes and workshops. Stay tuned for the 
schedule, to be announced as soon as detailed planning is completed. 
 
Scott Kelby Worldwide Photowalk 
Saturday, Oct. 3, is Worldwide Photowalk day. Organized by Scott Kelby, walks will take place in 
locations around the world. Each is an informal opportunity to explore and photograph a place of 
visual interest, while meeting new friends who enjoy photography. Here in Redlands our own Frank 
Peele will lead a walk on the campus of the University of Redlands; you can find details and sign up 
(it’s free) here. 

 
If you have any questions, please email:  educationworkshopsrcc@gmail.com. 

  

http://kelbyone.com/photowalk/walk/redlands-ca-united-states/
mailto:educationworkshopsrcc@gmail.com
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Southern California Council of Camera Clubs 
Deborah Seibly 

 
S4C Competitions Return September 19! 

The first S4C competition of the year begins September 19th, Entries can be submitted from the 19th 
through October 3rd. If you do not have a UEN (number required for entry), now is a good time to get 
one. There is no charge for submissions. Further details can be found on the S4C web site 
(http://www.s4c-photo.org). The web site lists other competitions, such as the Golden West Small 
Print competition, which may interest some members. I will be reviewing any changes to the 
competition rules for this year and will try to summarize those in the next newsletter. Please don't 
hesitate to contact me if you need assistance in any way. 
 
If you have any questions, please email:  dlseibly@gmail.com. 
 
 

Club Calendar   
    

             Information that was available to the editor at the time of publication.  
 

Aug 30 – Sept 7 Submit QuickPix Images: Seascapes and Costal Shots 
September 7 Shooting the California Coast with Photo with Ralph Nordstrom 
September 14-21 Submit QuickPix Images: Night Skies 
September 21 Blending Astronomy and Photography with Dr. Tyler Nordgren 
September 28 Begin Uploading Members’ Night Images 
October 5 Members’ Night – Submit Images Between Sept. 28th and Oct. 5th 
October 19 Pre Meeting Mentoring Session – 5:30pm 
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2015 Summer Competition – Second Place 
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(Note:  The views expressed in this article are those of the author and do not    
necessarily reflect the views of the Photogram or of Redlands Camera Club.) 
 
Creating Great Night Sky Images with Lightroom and Photoshop 
By John Williams 

 
• Purpose of this article: 
 Photographing the universe from Earth presents some unique challenges when shooting the 

night sky. Fortunately, you can fix problems using Lightroom and Photoshop to create 
images from vividly real to the artistic and abstract. 

 There is a lot of subtle color in the night sky that the camera captures.  The green is primarily 
“Airglow”, somewhat like the aurora.  The sun’s extreme ultraviolet light excites oxygen and 
nitrogen atoms in the upper atmosphere during the day.  The products then interact with 
other atmospheric components to later produce light emission by chemical luminescence at 
night.  The camera can detect this but our eyes cannot.  The yellow, orange, and red can be 
due to the setting sun or moon, and in large part due to light pollution.  Light pollution can be 
seen for hundreds of miles. 

• Lightroom Initial Basic Workflow:  Make all your normal RAW adjustment in Adobe Camera 
Raw or Lightroom: 
 If you’re going to be blending multiple exposures (focus stacking) in Photoshop you should 

make basic edits in Lightroom (or Camera Raw) first.  As a minimum you should correct 
White Balance, adjust Sharpening & Noise reduction, enable Lens Profile Corrections 
and Remove Chromatic Aberrations. 

 White Balance:  Chances are you’ll need to adjust the white balance of your photos to make 
the colors look more natural, but you can also use it for creative effect to shift the mood of the 
photo.  Remember, when you shoot RAW you can completely correct the white balance in 
software, you don’t have to worry about the adjustment causing artifacts in your photos.  Try 
a Temperature between 3500-4000°K.  Find a setting that is a balance between the cold 
blues and warm oranges.  If the sky is too green, you can add Magenta. 

 Tone Sliders:  Try adding some contrast to make the Milky Way pop.  Increase Exposure 
and see if it allows you to see more stars.  Increase the White slider and decrease the Black 
slider (avoid clipping blacks) to give the image more contrast. The Clarity slider can make 
the stars pop.  However, be careful when using it, you can easily add too much clarity and 
cause ugly halo artifacts, particularly around the horizon and stars.  Also try adding some 
Vibrance and Saturation. 

 Tone Curve:  Darkening the shadows and brightening the highlights often makes your image 
'pop.' 

 Hue/Saturation/Luminance:  Your goal is to adjust the sliders to find colors in the Milky Way 
that are more visible and visually pleasing. 

 Sharpening:  For night photography you can use it to sharpen up the stars a little bit and 
sharpen the foreground details, but the most important thing is make sure you’re not 
sharpening the noise in the photo.  You will want to adjust the Masking slider in the 
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Sharpening section of the Detail panel so that dark parts of the sky are not being sharpened.  
If you don’t do this, then the noise in the sky will be sharpened, which will make it more 
prominent.  Be sure you zoom into your image to see your adjustment.  Suggest initial 
settings are Amount 50, Radius 0.7, Detail 15-20 and Masking 50 

 Noise Reduction:  With high ISOs needed to capture the night sky you’ll probably find that 
your images will contain noise that should be removed.  The Adobe RAW editor will provide 
good noise reduction, but you’ll probably get better noise reduction by using a third party 
plug-in.  You will want to practice and find the right balance between smoothing out noise in 
the sky without smoothing out the stars and foreground.  Try using 50-80 on the Luminance 
slider and increase the Detail slider to 40-50.  Too much detail will introduce noise back into 
the photo.  To see Luminance noise hold down the Alt key and slide the Luminance slider.  
The image will turn to black and white allowing you to see luminance noise much better.  For 
Color noise reduction try these initial settings: Color 17-20, Detail 50 and Smoothness 100. 

 Lens correction:  In the Basic tab, check the Enable Profile Correction and Remove 
Chromatic Aberrations boxes.  Under the Manual tab and the Lens Vignetting section, 
you can move the Amount slider to the right to further lighten the edges after you enabled 
Profile Correction. 

 If you are not opening the image in Photoshop, use the Lightroom Adjustment 
Brush/Gradient tools: 
o To make the Milky Way pop, paint over the Milky Way using the Adjustment Brush tool 

and increase Temperature/Tint (use suttle setting), Exposure, Clarity and Saturation.  
After painting over the image, adjust the sliders to your liking.  The key is to paint 
accurately over the Milky Way.  You can paint in stages by selecting New which will give 
you a new control point. 

o Selective coloring to change the sky color:  Use the Adjustment Brush tool and click 
on the Color box and with the eyedropper tool 
select a suttle bluish color.  Paint over the sky 
area with a large brush.  If the color is too 
intense, move the slider on the Select a 
Color dialog box to the left and the area you 
painted over will reflect the color change.  
After painting over the image, you can hover 
the eyedropper over the colors and select a new color.  The key is to paint over large sky 
areas to make the sky even and natural looking. 

• Photoshop processing: 
 Basic adjustment to consider: 

o Consider using two adjustments: Brightness/Contrast adjustment (avoid blowing out the 
highlights) and using Photo Filter adjustment to adjust the color balance [consider using 
Cooling Filter (80)].  Be sure to use Masks to hide the adjustments in certain areas of the 
photo such as the Landscape areas.  To boost the stars, select Screen blending mode. 

o Correct color of the sky:  One give away that your sky is not naturally colored is if the 
sky is orange, brown, green or completely blue.  To correct the color, add a Levels 
Adjustment.  Change RGB to the Red channel and move the middle slider (midtones) to 
the right until the image becomes noticeably green.  Then change to the Green channel 
and move the middle slider to right until the sky becomes a pleasing color.  Next move 
change to the Blue channel and move the middle slider left and right to obtain a pleasing 
color.  Finally switch back to the RGB channel and move the middle slider to the left to 
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brighten (or right to darken).  To darken, move the right Output slider to the left.  
Alternatively, you can add a Curves Adjustment to lighten or darken the image.   

o To brighten the Milky Way add a Curves Adjustment and 
change the mask to black (click on the white Mask and 
depress Ctrl+I or select Invert in the Mask properties).  
Then paint with a white brush over the Milky Way (suggest 
you increase the midtone contrast before painting to see 
your brush strokes).  Click on the Mask and increase the 
Feather of the Mask or go to Filter > Blur > Gaussian Blur 
and significantly increase the pixel amount.  Place two adjust 
points on the curve inside the bell curve as indicated in 
figure.  To increase contrast raise the right control point up 
and move the left control point down.  Then to change the 
colors of the Milky Way select the Red, Green and Blue 
channels and adjust the color by moving the center point of the curve.  Alternative way to 
change color is to move the Black left Input slider to the right (very bottom left adjustment 
point) and do not add any control points to the curve. 

o To sharpen only the Milky Way, on a new layer go to Filter > Sharpen > Unsharp 
Mask.  Set the Radius between 40-50 and the Amount to 90.  Then add a Black Mask 
and paint with a White brush over the Milky Way.  Feather the mask as described above.  
The sharpening will probably be too much so reduce the Layer Opacity.  

o Reduce light pollution:  Near the horizon you will normally have light pollution and 
colors that do not complement the sky.   
 Duplicate the Layer (Ctrl+J) and add a Levels Adjustment. 
 Set the "black point", that is, the values of the darkest pixels in the image. These 

would represent the color and density of the sky background.  Select the Black 
eyedropper tool and click on the darkest point in the sky. 

 Select the Red channel and move the middle slider 
(midtone) underneath the histogram to the right until 
the sky turns green.  Then select the Green channel 
and move the slider to the right until you have a 
satisfactory color.  Then select the Blue channel and 
move the middle slider to the right/left until you have 
a pleasing color. 

 Increase Contrast:  Select the RGB channel and 
move the white levels slider (far right slider) and 
drag it to the left to increase contrast.  Note that as 
you move the white point slider to the left, you will 
start clipping highlight detail.  The stars in the image will grow larger as the contrast is 
increased. 

 Increase the Brightness:   While still in the Levels RGB dialog, you can increase the 
brightness of the mid-tones of the image by dragging the middle slider to the left. 

 Final adjustments:  To add punch to your photo, add a Hue/Saturation adjustment and slide 
the Saturation slider to the right to increase color saturation.  Also you can add a 
Brightness/Contrast adjustment and increase both sliders 
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o Luminosity Masking: Luminosity masks allow you to select certain areas of the image 
based on tonality (selections based on how brightness or darkness).   You can use 
luminosity mask adjustments in order to increase the brightness of the stars while leaving 
the darks areas of the photo untouched.  Luminosity Masks are made from the Channels 
palette. However, you must create them first, which is a rather time-consuming process 
(see instructions at http://design.tutsplus.com/tutorials/how-to-create-and-use-luminosity-
masks-in-adobe-photoshop--cms-23549).  Fortunately, there are various sources on the 
Internet where you can download pre-created Luminosity 
Masks action sets.  My favorite action is the Zone system by 
Blake Rudis (http://zone-edit.com/home/) and it allows you to 
run an Action that will divide the image into the 11 tonal Zones 
using a Curves Adjustments and Layer masks. The Curves are 
used to manipulated and adjust each tonal value in the Zone of 
choice without affecting the areas around them. 

 Alternative way to post process in Photoshop: 
o First depress the Create new group icon at bottom of Layers 

panel.  Then repeat adding a new group.  Name the bottom 
group Landscape and the top group layer Milky Sky-Sky. 

o Then make a selection of the sky or landscape that will give 
you the best selection.  Normally the Landscape will be dark 
and give you the best selection.  Next add a mask to the 
Landscape Group Layer.  Feather the selection about 1.5 -
pixels.  Click on the Mask while hold down the Alt key and 
move the mask up to the Stars-Sky Group and inverse (Ctrl+I) 
the mask. 

o Highlight the Land group and add a Curves Adjustment.  Then 
lighten or darken the land area. 

o With the Landscape Group Layer highlighted, depress the 
Create a new layer icon.  Then click on the Foreground color 
icon to bring up the Color Picker and select an Orange color.  Depress the Alt+Delete 
keys to fill the landscape area with the Foreground color (orange).  Change the Blend 
mode to Color and reduce the Opacity so you have a pleasing color.  Finally depress the 
Ctrl+U keys to bring up a Hue/Saturation adjustment and reduce the Saturation slider.  
You can also reduce the Lightness slider and adjust the Hue slider to change the color. 

o Remember in a Group Layer that the adjustment layer above affects the bottom 
adjustment layers. 

o Add a Curves Adjustment to the Sky group and make a contrast adjustment by 
increasing the Lights and decreasing the Darks.  

o Add a second Curves Adjustment and change RGB channel to Blue  Drop the curve line 
on the upper right side (lights) down to add some yellow and raise the lower right side 
(darks) curve line up to add some blue.  Then change the RGB channel to Red and move 
the center of the line up or down.  Repeat for the Green channel.  You probably will only 
make slight adjustments with the Red and Green channels.  Note to reset the curve for a 
particular channel, depress the Delete key. 

 How to make Star Trails Images:  Star trails is a photographic effect that gives an illusion of 
motion to the stars along a circular or an elliptical path.  Traditionally, star trails are captured 
by taking multiple shots of the sky in succession over a period of many hours to make almost 

http://zone-edit.com/home/
http://digital-photography-school.com/how-to-photograph-star-trails/
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a full circle of star trails.  However, the processes described below can give you good results 
using only seventy time-lapse exposures or one image. 
1. Star Trails Photoshop action — Single Image:  The Star trail action comes as part of 

Photoshop CS5 and above, and you will need to load the action.  To do so open the 
actions panel in Photoshop and the 
click on the top right of the actions 
palette on the fly out menu down 
arrow and select Stars Trails.  
Then duplicate your stars image 
and play the Stars Trails action.  
The action will rotate your single 
star image 0.2 degrees, then blend 
the rotated image with the original 
image using a lighten blend mode 
which makes the dark areas (black 
sky) transparent and then it 
repeats these steps 60 more times.  
The process can take a few 
minutes and you can apply the 
technique several times to create longer star trails.  The finished result is an image were 
the stars will appear to rotate about the center of the image.  A fuller explanation can be 
found at http://www.russellbrown.com/scripts_archive.html. 

2. StarStax  image stacking software — Merging Multiple Time-Lapse Images:  If you 
shot several images in succession, you would first post process one image in ACR 
including noise reduction and then SYNC the setting to all the other images.  Then use 
the StarStax software (freeware) to merge the series of sky photos into a single image, 
where the relative motion of the stars in consecutive images creates structures looking 
like star trails.  A fuller software explanation can be found at http://www.markus-
enzweiler.de/StarStaX/StarStaX.html.  Other software you can use to merge a series of 
photos are StarTrails (http://startrails.de/html/software.html) and Image Stacker 
(http://www.tawbaware.com/imgstack.htm). 

3. Merge multiple Time-Lapse Star Images using only Lightroom & Photoshop: 
o Download all your photos into Lightroom. 
o Adjust a single image (White Balance, Tone, Presence, Sharpening, Noise Reduction, 

Lens Correction, and Crop if necessary).  Next Sync all the images. 
o Then select all your images and then right-click and select Edit in > Open as Layers 

in Photoshop. 
o After all the images are loaded into Photoshop, select all the layers by clicking on the 

top layers and then hold down the Shift key while clicking on the bottom layer.  All the 
layers should be highlighted. 

o Align all your images by going to Edit > Auto-Align Layers.  When the Auto-Align 
Layers dialog box opens select Auto and then depress the OK button. 

o Next select all the layers EXCEPT the bottom layer.  Change the blend mode to 
Lighten on the selected layers.  Lighten will blend the lightest part of each layer and 
will now see a star trail photo.  You will probably see some extraneous light in the 
bottom landscape area.  NOTE:  You can reduce the opacity of each layers to create 
comet-like effects.  Start with the first at 100%, then change the next to 90% opacity, 
the third layer to 80%, the next layer to 70%, etc. 

http://www.russellbrown.com/scripts_archive.html
http://www.markus-enzweiler.de/StarStaX/StarStaX.html
http://www.markus-enzweiler.de/StarStaX/StarStaX.html
http://startrails.de/html/software.html
http://www.tawbaware.com/imgstack.htm
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o With all the Lighten photos still highlighted, go to Layer > Group Layers.  You could 
call the group Star Trails.  Next add a Mask to your Star Trails group. 

o Select the Mask and paint over the landscape area with black brush (100% Opacity 
and 100% Flow). 

o If there are streaks in the photo such as an airplane light trail, add a transparent layer 
(depress the Create a new layer icon at bottom of layers panel) to the top of all layers.  
Then with the Clone Stamp tool remove any unwanted objects or streaks. 

Finally you can flatten your layers or make a stamp of the visible layers (Ctrl+Shift+Alt+E).  Then 
post process your star trail image using the methods described above.

     
For Sale: New in Box 

Tascam DR-60D Digital Audio Recorder 
Want to greatly improve the audio quality of videos made with your DSLR, Mirrorless or other digital camera? 
Tascam, the professional division of Teac Audio, has your solution – the DR-60D 4-channel audio recorder. 
Built to mount under your camera either on or off a tripod, this recorder offers 2 professional balanced XLR or 
¼” TRS mic inputs plus a 3.5 mm stereo mic input. Its many modes allow you to capture very high-quality 
sound, tailor the sound to your preferences, and use microphones of widely different types. The LCD screen is 
fully visible in any lighting condition (even direct sunlight), and complete controls put you in charge of your 
recordings. Unit is in original box, has never been used, and comes with all included accessories. Sells on 
Amazon for $199; priced for quick sale at $150.  
Frank Peele, 909.798.7999, or email to FrankPeele@verizon.net  
  

mailto:FrankPeele@verizon.net
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ViewBug Online Photo Contests 
 
Hi RCC members,  

This is Stephanie and I want to invite you to view my ViewBug gallery of photographs. ViewBug is a contest 
site for  worldwide photographers of all  skill levels, amateur party shooters to professional international 
photographers.  I have been on the site for a little over a month and I’m enjoying it. I’m really inspired by the 
photos I’m looking at, and I’m encouraged by not only the peer awards I receive, but also through online 
conversations that I have with my fellow photographers. It’s truly a community of supporting photographers.   
You can visit my gallery at: http://www.viewbug.com/member/stebil30 

But like I stated its primary purpose are contests!  I’ve entered several of them, and now its time to vote.  The 
more votes an image gets the better chance it has of getting into the finals. The final images are then juried by 
a professional photographer (Scott Kelby has actually been one of the jurors—not to drop names or anything). 
I listed a few of mine that are now being voted on. Please take a look at them and vote for the ones that you 
like best, that’s if you like them. 

FYI: Non-members can only vote for 3 images then they will be asked to join ViewBug 

http://www.viewbug.com/contests/men-at-work-photo-contest/57412781   Vote until Sept 10th  
http://www.viewbug.com/contests/men-at-work-photo-contest/56886610   Vote until Sept 10th 

I hope you enjoy my gallery!!! 

Stephanie Billings 
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